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Overview
You may have heard that Response provides PowerPoint 
integration, but you may not be sure what that means. It 
means that you can transform your existing PowerPoint 
lecture slides into Response Questions with the click of a 
button. It means that you can use the powerful assessment, 
feedback, polling, and testing functionality of Response with-
out changing the way you teach with PowerPoint. It means 
that you simply install Response on your Windows or Mac 
system and the Response PowerPoint Add-In Utility automati-
cally adds the Response Toolbar to your PowerPoint applica-
tion on your Windows system, or you install it on your Mac. 
It means you just select a slide you want to make into a 
Response Question slide, click on the New Question tool on 
the Response Toolbar in PowerPoint, and select the proper-
ties you want to assign to the Question. Response recognizes 

that this is a Question slide when you run the slide show. 
It will display the Session Toolbar and automatically switch 
into PowerPoint Mode. You just start the Timer. Your students 
use their clickers to send their answers to the Question. 
When the Timer has expired, or you stop the Question, a 
Response Chart displays where you can view the distribution 
of the answers. You can immediately assess your students’ 
understanding of the material being presented and, based 
on this instant feedback, you can continue with the lecture 
slide show, go back to previous slides, or add a new slide 
that approaches the topic from a different perspective. The 
on-the-spot assessment that Response provides is a powerful 
tool that gives you the flexibility to react immediately to your 
students and their educational needs.

Installation
The Response software is distributed on a CD or can be downloaded from our Web site at www.interwritelearning.com. 
While Response is supported on Windows, Mac and Linux, the PowerPoint Add-In is available only on Windows and Mac, so 
only those installations are described here.

Windows Installation
The Response software is compatible with Windows 2000, XP and Vista.

Install from CD
The Response software must be installed on the Windows 
system by someone with Administrator privileges.

1	 Log in as Administrator.

2	 Insert the Interwrite Response CD into the computer’s 
CD-ROM drive. The CD will autorun. 

	 If the CD does not autorun, click on the Start button on 
the Windows Task Bar and select Run from the menu. 
Click on the Browse button. Navigate to the CD-ROM 
drive and double-click on autorun.exe.

3	 Click on the Install Interwrite Response Software menu 
option.

4	 Follow the onscreen instructions for the software installa-
tion.

Install from Download
If you are installing downloaded Response software: 

1	 Navigate to the location on your computer where you 
downloaded the software. 

2	 Double-click on the downloaded file to start up the 
install program.

3	 Follow the onscreen instructions for the software installa-
tion.



  2 How To Series
Interwrite Response

How To Use PowerPoint with Response
www.einstruction.com

The PowerPoint Response Add-In Utility
When Response is installed, the Response Toolbar is automatically added to Microsoft PowerPoint (version 2000 or newer) 
by the PowerPoint Response Add-In Utility. This is done by registering the Add-In on the system on which Response is in-
stalled. The registration of the Response Add-In must be done by a user with Administrator privileges. However, since the in-
stallation of the Response software must be performed by a user logged in as Administrator, the registration of the Response 
Add-In is automatic and occurs as part of the software installation. If the Response Toolbar does not show up in PowerPoint, 
you can register the PowerPoint Response Add-In Utility—close PowerPoint and select Start/Programs/Interwrite Learn-
ing/Interwrite Response/Install support for PowerPoint. When the Add-In has been installed, the Response Toolbar will 
display in PowerPoint making it possible to easily craft Question slides in PowerPoint lectures.

If at any time you wish to uninstall the Response Toolbar from PowerPoint, simply login as Administrator (or login using your 
user login) and select Start/Programs/Interwrite Learning/Interwrite Response/Uninstall support for PowerPoint.

The Response Toolbar 
in PowerPoint 2003 on 
Windows 2000 and XP

The Response  
Toolbar in  
PowerPoint 2007  
on Windows Vista
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Install the PowerPoint Response Add-In Utility Manually in 
PowerPoint 2003
The following steps describe how to manually install the PowerPoint Response Add-In Utility in PowerPoint 2003 on 
Windows 2000 and XP:

1	 Open PowerPoint and select the Tools Menu.
2	 Select the Customize... menu option.
3	 Click on the Commands tab. In the left pane, click on Tools. In the right pane, scroll to COM Add-Ins.
4	 Drag the COM Add-Ins selection to your PowerPoint Toolbar and drop it next to the blue and white Help button.
5	 Click on the Close button to close the window.
6	 Click on the COM Add-Ins tool you just added to the PowerPoint Toolbar to display the COM Add-Ins dialog.
7	 Click on the Add... button. Navigate to the folder in which Response is installed and select PRSAddIn.dll. By 

default, Response is installed in Program Files\Interwrite Learning\Interwrite Response.
8	 Click on the OK button. The PRS Com Add-In should display in the Add-Ins available list with a check.
9	 Click on the OK button. The Response Toolbar should now appear in PowerPoint as shown above.

If the Response Toolbar fails to appear in PowerPoint, please contact Response Technical Support at 480.443.2214.

Install the PowerPoint Response Add-In Utility Manually in 
PowerPoint 2007
The following steps describe how to manually install the PowerPoint Response Add-In Utility in PowerPoint 2007 on 
Windows 2000 and XP:

1	 Open PowerPoint and click on the Office Button.
2	 At the bottom of the Office drop-down menu, click on the PowerPoint Options button.
3	 In the left pane of the PowerPoint Options window, click on the Add-Ins button. 
4	 At the bottom of the Add-Ins pane, locate the Manage field and click on the arrow to display the drop-down 

list. Select the COM Add-Ins option.
5	 Click on the Go button next to the field.
6	 In the COM Add-Ins dialog that displays, click on the Add... button. 
7	 Navigate to the folder in which Response is installed and select PRSAddIn.dll. By default, Response is installed in 

Program Files\Interwrite Learning\Interwrite Response.
8	 Click on the OK button. The PRS Com Add-In should display in the Add-Ins available list with a check.
9	 Click on the OK button. The Response Toolbar should now appear in PowerPoint as shown above.

Note:  If you are running PowerPoint 2007 on Windows Vista, you will 
not be able to add the PowerPoint Response Add-In utility manually.
In any case, if the Response Toolbar fails to appear in PowerPoint, 
please contact Response Technical Support at 480.443.2214.

If the Response Toolbar does not install automatically when Response is installed, and it does not display when the Install 
support for PowerPoint option has been run, follow the instructions below to manually install the PowerPoint Response Add-
In Utility either on PowerPoint 2003, or on PowerPoint 2007.
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Install the PowerPoint Response Add-In Utility
The following steps describe how to install the Response PowerPoint Add-In Utility on  
the Mac:

1	 Open PowerPoint and select the PowerPoint Menu.

2	 Select the Preferences... menu option.

3	 Click on the View tab and uncheck the Project Gallery at startup option.

4	 Click on the OK button.

5	 Select the Tools Menu.

6	 Select the Add-ins... menu option.

7	 Click on the Add... button. Navigate to the folder in which Response is installed.  
By default, Response is installed in the Interwrite Learning\Interwrite Response 
folder in Applications.

8	 Select the PRS AddIn.ppa file and click on the Open button.

9	 The Response Add-in file will be listed in the Add-in List. Click on the OK button.

10	 Restart PowerPoint.

By default, the Response Toolbar displays down the left side of the PowerPoint window. 
You can move it by grabbing the spot next to the Close button and dragging it to the 
top of the window where the other Toolbars are located. Click and drag the Resize but-
ton to change the Response Toolbar’s orientation.

Mac Installation
The Response software is compatible with Mac OS X 10.4 (Tiger) or higher and Java 1.5 or higher. 

Install from CD
The Response software must be installed on the Mac by an 
Admin.

1	 Log in as Admin.

2	 Insert the Interwrite Response CD into the computer’s 
CD-ROM drive. When it appears on your Desktop, 
double-click on the CD icon.

3	 Double-click on the Install Interwrite Response icon.

4	 Follow the onscreen instructions for the software installa-
tion.

Install from Download
If you are installing downloaded Response software: 

1	 Navigate to the location on your computer where you 
downloaded the software. 

2	 Double-click on the downloaded file to start up the 
install program.

3	 Follow the onscreen instructions for the software installa-
tion.
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Installing Response on a USB Drive
Response can be run from a removable drive, such as a USB thumb drive, or from a network drive, making it convenient 
for instructors who want to run Response from different computers in different classrooms without having to install Response 
on each one. In addition, the Response Database is stored on the USB or network drive along with the application, making 
Response a completely portable system. 

Installing Response on a USB 
Drive on Windows
Proceed with the Response installation either from the 
Response CD, or from the file downloaded from our Web 
site, as documented on page 1. Follow the onscreen 
instructions for the software installation. When you are 
asked to specify the install location of Response, change 
the drive designation to point to your USB thumb drive. 
The installation directory is Interwrite Response. Click 
on the Next button to start the installation of Response on 
the USB drive.

Installing Response on a USB 
Drive on a Mac
Make sure the thumb drive you are using is compatible 
with your Mac, then connect it to an available USB port.

Proceed with the Response installation on your Mac 
either from the Response CD, or from the file down-
loaded from our Web site, as documented on page 1. 
Follow the onscreen instructions for the software instal-
lation. When the directory name screen comes up, click 
on the Browse button. Select <computername>/
Volumes/<AttachedDriver> and click on the OK 
button. Continue the Response installation on your USB 
drive, following the onscreen instructions.

Known Mac Issues:
•	 The driver does not always mount the first 

time it is tried on the Intel Mac.
•	 Not all USB drives are compatible with the 
Mac. Make sure you select a USB thumb drive 
that is going to work with your Mac model.

We recommend that you store your Response data direc-
tories and your Preferences settings file on the USB drive 
along with the Response software.

•	 If Response has already been installed on the com-
puter, and you would prefer to have the data direc-
tories and Preferences file on your USB drive so you 
can take them with you, move the directories to the 
USB drive and delete the Pref.prs file from the My 
Documents directory.

•	 If you are going to move your Response data di-
rectories from the My Documents directory on the 
computer to your USB drive, do it before you start up 
Response from the USB drive.

Starting Response

1	 To start up Response from the USB thumb drive or 
from a network drive, go to the Response installation 
directory.

2	 Double-click on the PRS.exe application file.

If this is the first time Response has been started from the 
new location, Response will prompt you to select where 
you want to store your Response data and preferences 
files. 

Starting Response from the USB Drive or from a Network Drive

We recommend the USB drive be password-
protected to prevent others from viewing the 
data stored on this device.

Recommended USB Drive Requirements:
•  USB 2.0
•  1GB or more storage capacity
•  The ability to password-protect the contents of the drive
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Always start Response before starting PowerPoint. Double-click on the PRS.exe file in the 
Response installation directory on the USB drive, then start PowerPoint. 
The Response PowerPoint Add-in could get unregistered if you fail to start Response before 
you start PowerPoint. You will know the PowerPoint Add-in has been unregistered if the 
Response Toolbar no longer appears in PowerPoint.

Using PowerPoint with Response on a 
USB Drive
If you want to use the Response PowerPoint Add-in to craft Question slides when you are running Response from a USB or 
Network drive, you must register the PowerPoint Add-in.

Double-click on RegisterPRSAddIn.exe in the Response installation directory on your USB thumb drive. This is a onetime 
operation. You never have to register the Add-in again – unless it is unregistered.
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Tool Description

New Question

Click on the New Question tool to make the current slide a Response Question slide. 
The Question Properties dialog is displayed. You select the properties you want to 
assign to the Question. The Question Properties are saved with the slide. A Response 
logo is placed on the slide to indicate it is a Response Question slide. During a Re-
sponse PowerPoint Session, the appearance of this logo will trigger a number of auto-
mated settings, making the whole process integrate seamlessly into your lecture.

Edit Question
Click on the Edit Question tool to display the Edit Question Properties dialog so you 
can edit the PowerPoint slide’s question properties. This tool is available only when you 
are on an existing Response Question slide in the PowerPoint presentation file.

Delete Question

Click on the Delete Question tool when you no longer want the current PowerPoint slide 
to function as a Response Question slide. This tool removes the Response logo from 
the slide and deletes the Question Properties that were saved with the slide. It does not 
affect the content of the PowerPoint slide itself. The Delete Question tool is available 
when you are on an existing PowerPoint slide with a Response Question.

About Response
The About Response tool displays the About dialog with information about the Inter-
write Response PowerPoint COM Add-In Utility, which installed the Response PowerPoint 
Toolbar.

The PowerPoint Response Toolbar
Any PowerPoint slide in any PowerPoint presentation file has the potential to become a Response Question slide. It is simply 
a matter of applying Response Question Properties to the PowerPoint slide. That is done quickly and easily by clicking on the 
New Question tool on the PowerPoint Response Toolbar. The properties or attributes you assign to the Question are saved 
with the slide in the PowerPoint presentation file, but they in no way affect the content of the slide. The only visible differ-
ence on the slide is the appearance of the Response logo, which indicates that this is a Response Question slide. The tools 
installed by the Response PowerPoint Add-In Utility can only add, edit, or remove the question properties from a Question 
slide, it has no control over the content of the PowerPoint slide.

The PowerPoint Response Toolbar tools are described in this section. The Question Properties assigned by the New Question 
tool to a PowerPoint slide are discussed in the next section.
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Response PowerPoint Question 
Properties
As you will see in the Question Properties dialog below and the table on the following page, Response supports a variety of 
Question Types. However, you will be limited to the types of questions you can choose by the types of clickers your students 
are using in your classes. 

You will need to know which types of clickers are going to be used in your 
Class and the Question Types they support before you begin adding Questions 
to your PowerPoint slides. If you are going to be using a mix of clickers in your 
Class, you must target your questions to the lowest common denominator.

The table of Question Properties on the next page describes each of the prop-
erties settings you can assign to your Response PowerPoint Question slides.

PRS RF Clicker

The PRS RF Clicker has an LCD display. Students are able to 
enter multi-character responses before they send their 
answers, so they can respond to multiple-correct 
Multiple Choice, Short Answer, Answer  
Series, and Numeric Question 
Types.

Cricket

Cricket and IR Clickers are 
limited to single-answer 
Multiple Choice and True/
False Question Types.

IR Clicker
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Question 
Property

Description

Question 
Name

Enter the name of the Question. This is the name that will identify the Question in the Status Bar be-
low the Session Toolbar and in the Questions pane on the Responses tab in the Session Data dialog.

Question 
Type

Choose a Question Type.

Multiple Choice,  
Single Correct

Where students choose one correct answer from the answer choices.

Multiple Choice,  
Multiple Correct

Where students choose all of the answers that are correct from the list of 
choices. (PRS RF Clickers only)

True/False
True/False Questions have two answer choices, True or False. Crickets and RF 
Clickers have a T button and an F button. IR Clickers use the 1A key for True 
and the 2B key for False.

Series
Where students arrange the answers in the correct order. All of the answer 
choices are included in the correct answer, which is a string with the answer 
choices in the correct order. (PRS RF Clickers only)

Short Answer
Where students type the correct answer using Input Keys. The answer can be 
no more than 11 characters long. (PRS RF Clickers only)

Numeric
Where students enter the numeric answer using the numeric Input Keys. The 
answer can be up to 11 numeric characters plus the minus sign or the decimal 
point. (PRS RF Clickers only)

Survey
A Survey Question is asking for an opinion or to gauge the audience’s knowl-
edge of the material being presented. There is no correct answer.

Choices  
Type

This option is available only when you are composing Multiple Choice, Answer Series and Survey 
Question Types. Do you want your Response Choices to be lettered or numbered? A consideration 
that may affect your selection - you can define up to 5 lettered answer choices, while you can define 
up to 10 numbered answer choices.

Number of 
Choices

Select the number of answer choices, the possible answers, you want to define for this Question. 
Click on the Hide checkbox if those answer choices are going to be presented during the Session by 
a means other than Response.

Points Indicate the number of points students will be awarded for a correct answer.

Correct  
Response

Indicate the correct answer. If you selected a Series or Short Answer Question Type, the field will be 
blank. An answer for a Series Question should be a character string with no spaces, e.g., DBCA or 
43621725. An answer for a Short Answer Question can contain up to 11 alphanumeric characters. 
If the Question Type was Numeric, two fields will display, Low and High. If the Numeric Question has 
only one numeric value as the correct answer, that answer should be entered in the Low field. If the 
correct Numeric answer falls within a numeric range, the low value and the high value that define 
the range should be entered in their respective fields.

Number of 
Chances

Indicate how many times students can change their answers to the Question within the allotted time. 
Answers transmitted after all the chances have been taken will be ignored.

Timer Indicate the amount of time students will have to respond to this Question.
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The Response PowerPoint Session
You have seen how easy it is to use the Response PowerPoint 
Add-In Utility to turn any of your existing PowerPoint lecture 
slides into Response Question slides without impacting the 
content or integrity of the PowerPoint slides. You can edit the 
Response Question Properties or delete them, completely re-
moving them from the PowerPoint slide without affecting the 
content of the slide. Conversely, you can edit a slide in Pow-
erPoint, completely change its content and move it around in 
the PowerPoint presentation file, but as long as the Response 
logo remains somewhere on the slide, it will continue to be 
a Response Question slide, and it will behave accordingly. 
Which brings us to using your PowerPoint lecture during an 
actual Response Session. How does it work?

The students in your class use electronic clickers to transmit 
their answers to the questions on the slide during a specified 
period of time. Each student’s answer is electronically scored 

and recorded, and the results are displayed in a Response 
Chart, which provides an opportunity for instant feedback 
and assessment of your students’ understanding of the ma-
terial being presented. Based on what you have seen, you 
can move ahead to the next slide in the lecture, or you can 
go back and review previously covered material, or you can 
add a new Question slide that approaches the material from 
a different point of view providing a flexible, assessment-
oriented approach to teaching.

The Class is at the center of the successful use of Response. 
Your students are associated with your Class by means of 
the Roster. Your Class must be set up before you begin the 
Response PowerPoint Session. The Roster doesn’t have to be. 
To learn more about profiling a Class and creating the Ros-
ter, please refer to How To Create and Manage your Class 
and Roster.

Once your Class is defined, you are ready to begin using Response and PowerPoint. The basic 
steps are outlined below. Additional details about these steps are provided on the following pages.

Running a Response PowerPoint Session

1	 Start up Response.

2	 Click on the Collect Responses icon.

3	 Configure your New Session as described in the following table.

4	 When the Session Toolbar has displayed, direct your students’ 
attention to the yellow RF Status Bar and the Join Code(s), and 
instruct your students to join the Class.

5	 Start your PowerPoint lecture.
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Configure a New Session
When you click on the Collect Responses icon on Response’s main screen, the Collect Responses – New Session 
dialog displays. The table describes how to configure your PowerPoint Session.

Field Description

Name
The name of the Session is generated automatically. It is a combination of the name of 
the Class and today’s date and time. If you run more than one Session for the Class 
today, the Sessions will be sequentially numbered. This field is editable.

Class Select the name of your Class from the drop-down list of Classes. The name of the 
Session will change if you select a different Class from the list.

Subject/ 
Section

If you defined Subjects or Sections for your Class, select the Subject or Section with 
which this Session will be associated from the drop-down list.

Type Select Participation. Participation is the only type of Session you can run for a Power-
Point lecture.

Lesson 
Type

Select Impromptu. When the Impromptu Options dialog displays, click on the OK 
button to dismiss it and display the Session Toolbar.

When you click on the OK button to accept the New Session 
settings, the Impromptu Options dialog displays. Click on 
the OK button to dismiss the Impromptu Options dialog and 
display the Session Toolbar. Instruct your students to turn 
on their clickers. 

The Join Code is displayed in the yellow RF Status Bar 
across the bottom of the Session Toolbar. It is enclosed in 
angle brackets to the right of the Broadcast Name or the 
words Join Code. The Join Code for RF Clickers is the sin-
gle-character code – 1 through 9, or A through F. Students 
press the appropriate Input Key on their RF Clicker keypads 
and press the green Send key to send the Join Code to the 

RF Receiver. You will see the Joined Counter at the far right 
end of the Status Bar increment as students join the Class.

The Join Code for Crickets is the two-digit value in the angle 
brackets. Students press the keys of the Join Code sequen-
tially, in the order they appear in the angle brackets. As 
each student joins the Class, the Joined Counter on the 
right end of the yellow Status Bar will increment.

If your students are using a mix of Crickets and RF Clickers, 
be sure to point out that the single-character Join Code is 
for the RF Clickers and the double-digit Join Code is for the 
Crickets.

Join the Class
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We have pointed out that one of the benefits of using the Re-
sponse system with your PowerPoint lectures is that you are 
able to quickly assess how well your students understand the 
material being presented. When you see that you are mov-
ing too quickly, you can go back to previous slides, or when 
things are clicking, you can jump ahead. There are also 
those times when you want to go off in a different direction 
and you have nothing prepared in this lecture. That’s when 
you have to decide whether you want to switch modes and 
pose an impromptu question, or create a new PowerPoint 
slide.

It’s easy enough to do either one. To create a new Power-
Point slide, click on the Insert Question tool  on the Ses-
sion Toolbar. The Interwrite Response PowerPoint COM 
Add-in dialog displays. Set the Question Properties for the 
new slide, select None as the Correct Response, and click 
on the Insert New Slide radio button. When you click on the 
OK button, a blank Question slide displays. Craft the ques-
tion and answer choices, if appropriate, and click on the OK 
button. The new Question slide will display and you can start 

the Timer. When the Timer expires or you stop it and the 
Response Chart displays, you will click on the Edit Question 
Properties tool  and indicate the real correct answer. The 
Response Chart will reconfigure. The new slide will be saved 
in the lecture at this point in the PowerPoint file.

To create an Impromptu Question, click on the Switch to 
Impromptu Mode tool . You will be prompted to discon-
nect the PowerPoint slide show. Set the Impromptu Question 
Properties in the dialog and present the impromptu Ques-
tion to the students. With either option, you achieve the 
desired results. You just have to decide whether you want 
to save a new Question slide in your lecture file or, if you 
go the impromptu route, whether you want to disconnect 
from the PowerPoint lecture. If you want to continue with the 
lecture slide show after running an impromptu Question, 
you have to restart it and get back to where you were, which 
might be distracting. We recommend you add new slides if 
you are in the middle of the lecture slide show and switch 
modes when you have ended the slide show.

Switching Modes vs Adding a Question Slide

Remind students using RF Clickers to press a key to wake up their clickers before they enter their answers.

Watch the Response Counter to determine when all the students have answered the Question. You can stop the Timer or 
wait until the Timer expires. When you have finished with the Session, click on the Exit tool at the right end of the Session 
Toolbar. In the next dialog that displays, click on the End the Class icon. You can learn more about the Response Session in 
How To Setup A Session and Collect Responses.

Run Your PowerPoint Session
When the Joined Counter indicates that all the students have joined the Class, start up your PowerPoint lecture. A message 
will display about activating the Response Session. Ignore the message and click on Yes. You have already started the Re-
sponse Session so you are ready to go. Note that on the Session Status Bar below the tools, the Session Type has switched 
to PowerPoint and it is showing the name of the first Question. When you are ready, start the Timer by clicking on the Start 
Question tool . 


